
 

 

 

 

 

 

 

 

 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

 

 

 

 

 

 

 

 

Release Notes 

 

 





 

 

 

 

Rhapsody
®
 

 

 

 

 

 

IBM® Rational® Rhapsody® 

Gateway Add On 
 

Release Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



License Agreement 

No part of this publication may be reproduced, transmitted, stored in a retrieval system, nor translated 

into any human or computer language, in any form or by any means, electronic, mechanical, magnetic, 

optical, chemical, manual or otherwise, without the prior written permission of the copyright owner. 

The information in this publication is subject to change without notice, and Dassault Systèmes and its 
affiliates assume no responsibility for any errors which may appear herein. No warranties, either 

expressed or implied, are made regarding Rhapsody software and its fitness for any particular purpose. 

Trademarks 

Reqtify is a registered trademark of Dassault Systèmes or its affiliates in the US and/or other 

countries. 

Rhapsody Gateway, IBM, the IBM logo, DOORS and Rhapsody are trademarks or registered 

trademarks of IBM Corporation. 

All other product or company names mentioned herein may be trademarks or registered trademarks of 

their respective owners. 

© Copyright 2001-2012 Dassault Systèmes. All rights reserved. 

 



 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

5 

 

Contents 

Contents ................................................................................................................................ 5 

Preface ................................................................................................................................ 11 

Gateway 1.0 – Build 1357 ................................................................................................... 12 

Gateway 1.0 – Build 1396 ................................................................................................... 14 

Gateway 1.0 MR2 – Build 618 ............................................................................................ 15 

Improvements of the DOORS interface ........................................................................................ 15 

Changes in the Main Window ...................................................................................................... 15 

Changes in the Configuration windows ........................................................................................ 16 

Reports Generation ...................................................................................................................... 18 

Support of Chinese and Japanese documents ................................................................................ 18 

Gateway 1.1 – Build 742 ..................................................................................................... 19 

Simulink Interface........................................................................................................................ 19 

Gateway files can be managed using Rhapsody CM capabilities ................................................... 19 

Option “1 module per package” for DOORS ................................................................................ 19 

Support of SysML and DoDAF Profiles ....................................................................................... 19 

Improved management of requirements creation .......................................................................... 20 

Improved Documentation & Examples ......................................................................................... 20 

Gateway 1.1 – Build 743 ..................................................................................................... 21 

Extended Rhapsody Types Definitions ......................................................................................... 21 

Gateway 1.1m1 – Build 319 ................................................................................................ 22 

Support of DOORS 8.0 ................................................................................................................ 22 

Support of new Rhapsody requirements definition........................................................................ 22 

Automatic allocation of Rhapsody type ........................................................................................ 22 

Detection of ‘moved’ elements ..................................................................................................... 23 

Change concerning of DOORS ‘in-links’ ..................................................................................... 23 

Word-SysML example ................................................................................................................. 23 

Change in initial project configuration.......................................................................................... 23 

Gateway 1.1m1 – Build 335 ................................................................................................ 24 

Support of DOORS 8.0.5 ............................................................................................................. 24 

DOORS Export Window .............................................................................................................. 24 

Requirements creation into Rhapsody .......................................................................................... 24 

Analysis of Rhapsody models ...................................................................................................... 24 

Gateway 1.2 – Build 343 ..................................................................................................... 25 

Support of DOORS 8.0.6 ............................................................................................................. 25 



Contents 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

6 

Lower rights needed for DOORS modules ................................................................................... 25 

Analysis of Rhapsody models ...................................................................................................... 25 

Gateway 1.3 – Build 168 ..................................................................................................... 26 

Support of DOORS 8.1 ................................................................................................................ 26 

Performances Improvement.......................................................................................................... 26 

Documentation Improvement ....................................................................................................... 26 

Navigation from DOORS to Rhapsody ......................................................................................... 26 

Support of the Functional C profile .............................................................................................. 26 

Gateway 1.3 – Build 175 ..................................................................................................... 27 

Support of the AUTOSAR profile ................................................................................................ 27 

Gateway 1.4 – Build 83 ....................................................................................................... 28 

Global Improvements ................................................................................................................... 28 

Improvements of the Requirements Detail view ........................................................................... 29 

Improvements of the Graphical view ............................................................................................ 29 

Creation of a new tagging feature ................................................................................................. 30 

Update of the AUTOSAR profile ................................................................................................. 30 

Support of the Testing profile ....................................................................................................... 30 

RG 1.4 – Build 137w32 - 138x ............................................................................................ 31 

Update of the AUTOSAR profile ................................................................................................. 31 

Support of DOORS 8.2 ................................................................................................................ 31 

CaliberRM Interface .................................................................................................................... 31 

Rhapsody Gateway Limitations (LINUX) .................................................................................... 31 

RG 1.4m1 – Build 179w32 - 180x ....................................................................................... 32 

Support of DOORS 8.3 ................................................................................................................ 32 

RG 1.5 – Build 581w32 - 580x ............................................................................................ 33 

Global Improvements ................................................................................................................... 33 

Interfaces Improvement ............................................................................................................... 37 

Documentation Improvements ..................................................................................................... 40 

RG 1.5 – Build 664w32 - 665x ............................................................................................ 41 

DOORS Interface......................................................................................................................... 41 

Internal Gateway Modification Files ............................................................................................ 41 

RG 1.6 – Build 339w32 - 340x ............................................................................................ 42 

Documentation ............................................................................................................................ 42 

Rhapsody Interface ...................................................................................................................... 42 

DOORS Interface......................................................................................................................... 43 

RG 1.6 – Build 352w32 - 354x ............................................................................................ 44 

Gateway Kernel ........................................................................................................................... 44 

Rhapsody Interface ...................................................................................................................... 44 

DOORS Interface......................................................................................................................... 44 

RG 1.7 – Build 18w32 - 19x ................................................................................................ 45 

Red Hat Enterprise Linux 5 .......................................................................................................... 45 



Contents 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

7 

Eclipse Integration ....................................................................................................................... 45 

Rhapsody Interface ...................................................................................................................... 45 

DOORS Interface......................................................................................................................... 45 

RG 1.7 – Build 44w32 - 45x ................................................................................................ 46 

International Support ................................................................................................................... 46 

Kernel .......................................................................................................................................... 46 

Documentation ............................................................................................................................ 46 

Rhapsody Interface ...................................................................................................................... 47 

DOORS Interface......................................................................................................................... 47 

RG 7.5 – Build 560w32 - 561x ............................................................................................ 49 

Usability Improvements ............................................................................................................... 49 

DOORS Interface......................................................................................................................... 51 

Rhapsody interface ...................................................................................................................... 55 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 56 

RG 7.5 – Build 570w32 - 571x ............................................................................................ 57 

DOORS interface ......................................................................................................................... 57 

Rhapsody interface ...................................................................................................................... 57 

RG 7.5.1 – Build 610w32 - 609x ......................................................................................... 58 

Gateway Lite Mode...................................................................................................................... 58 

Internationalization ...................................................................................................................... 58 

Gateway fixes .............................................................................................................................. 59 

Rhapsody interface ...................................................................................................................... 59 

RG 7.5.1 – Build 627w32 - 628x ......................................................................................... 60 

Rhapsody interface ...................................................................................................................... 60 

DOORS interface ......................................................................................................................... 60 

RG 7.5.2 – Build 2788w32 – 2789x ..................................................................................... 61 

Global Improvements ................................................................................................................... 61 

Performance Improvements.......................................................................................................... 64 

Rhapsody Interface ...................................................................................................................... 65 

DOORS Interface......................................................................................................................... 65 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 67 

RG 7.5.2.1 – Build 2802w32 - 2803x ................................................................................... 69 

Coverage Analysis ....................................................................................................................... 69 

DOORS interface ......................................................................................................................... 69 

XML Tester ................................................................................................................................. 69 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 69 

RG 7.5.3 – Build 2958w32 – 2959x ..................................................................................... 70 

Performance Improvements.......................................................................................................... 70 

Rhapsody Interface ...................................................................................................................... 70 

Support of DOORS 9.3 ................................................................................................................ 71 

DOORS Interface......................................................................................................................... 71 



Contents 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

8 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 72 

RG 7.5.3.1 – Build 2964w32 – 2965x .................................................................................. 73 

DOORS Interface......................................................................................................................... 73 

RG 7.6 – Build 1522w32 – 1523x ........................................................................................ 75 

Rhapsody interface ...................................................................................................................... 75 

DOORS Interface......................................................................................................................... 79 

ExcelXML and CsvXML ............................................................................................................. 81 

RG 7.6.0.1 – Build 1529w32 – 1530x .................................................................................. 83 

Rhapsody interface ...................................................................................................................... 83 

DOORS interface ......................................................................................................................... 83 

RG 7.6.1 – Build 1869w32 – 1870x ..................................................................................... 85 

Support of DOORS 9.3.0.4 .......................................................................................................... 85 

Support of RequisitePro 7.1.3....................................................................................................... 85 

Rhapsody interface ...................................................................................................................... 85 

DOORS interface ......................................................................................................................... 87 

RG 7.6.1.1 – Build 1873w32 – 1874x .................................................................................. 89 

Windows 7 installation ................................................................................................................. 89 

Microsoft Office 2010 .................................................................................................................. 89 

DOORS interface ......................................................................................................................... 89 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 89 

RG 7.6.1.2 – Build 1883w32 – 1884x .................................................................................. 91 

Support of DOORS 9.4 ................................................................................................................ 91 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 91 

RG 8.0 – Build 586w32 – 587x ............................................................................................ 92 

Global Improvements ................................................................................................................... 92 

Rhapsody Interface ...................................................................................................................... 94 

DOORS Interface......................................................................................................................... 97 

Rhapsody / DOORS Bidirectional Synchronization ...................................................................... 98 

RG 8.0.1 – Build 592w32 – 593x ......................................................................................... 99 

Support of DOORS 9.5 ................................................................................................................ 99 

DOORS interface ......................................................................................................................... 99 

RG 8.0.2 – Build 602w32 – 604x ....................................................................................... 101 

Rhapsody interface .................................................................................................................... 101 

RG 8.0.3 – Build 561w32/w64 – 563x ............................................................................... 103 

Global Improvements ................................................................................................................. 103 

Find Dialog ................................................................................................................................ 106 

Filters ........................................................................................................................................ 106 

Definition of default Text Editor ................................................................................................ 107 

Microsoft Office 2013 ................................................................................................................ 107 

Support of DOORS 9.5.1 ........................................................................................................... 108 

New Word Converter ................................................................................................................. 108 



Contents 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

9 

Code C#..................................................................................................................................... 109 

Rhapsody interface .................................................................................................................... 110 

DOORS Interface....................................................................................................................... 112 

RG 8.0.4 – Build 765w32/w64 – 766x ............................................................................... 113 

Support of DOORS 9.5.1.2 ........................................................................................................ 113 

Rhapsody interface .................................................................................................................... 113 

RG 8.0.5 – Build 777w32/w64 – 778x ............................................................................... 115 

General Improvements ............................................................................................................... 115 

Support of DOORS 9.5.2 ........................................................................................................... 115 

Rhapsody Interface .................................................................................................................... 115 

RG 8.0.6 – Build 794w32/w64 – 795x ............................................................................... 117 

Global Improvements ................................................................................................................. 117 

Support of DOORS 9.5.2.1 ........................................................................................................ 118 

Rhapsody Interface .................................................................................................................... 118 

Rhapsody / DOORS Bidirectional Synchronization .................................................................... 119 

RG 8.1 – Build 523w32/w64 – 524x .................................................................................. 121 

General Improvements ............................................................................................................... 121 

DOORS Interface....................................................................................................................... 123 

Rhapsody Interface .................................................................................................................... 124 

RG 8.1.1 – Build 533w32/w64 – 534x ............................................................................... 125 

Code C, C++ and C# .................................................................................................................. 125 

Code C AUTOSAR ................................................................................................................... 125 

Rhapsody interface .................................................................................................................... 126 

RG 8.1.2 – Build 340w32/w64 – 336x ............................................................................... 127 

General Improvements ............................................................................................................... 127 

Microsoft Word Viewer ............................................................................................................. 129 

Code C, C++ and C# .................................................................................................................. 130 

DOORS Interface....................................................................................................................... 130 





 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

11 

 

Preface 

RG is a full requirements traceability solution, integrated in the Rhapsody environment. 

The project to be analyzed must be configured in RG, specifying the nature of files to be 

processed (Word, FrameMaker, UML analysis tools, Design tools, etc.), their location, 

links between them and requirements traceability information to be searched for in each of 

these files. 

RG analyzes the documents and produces an image of requirements traceability 

information in relation to the project as a whole. It is then possible to set reference 

versions that can be transmitted if necessary to a configuration management tool, and 

generate analysis documentation in customized formats. 

RG provides the following features: 

 a configuration editor for definition of the project graph, 

 converters for importing different kinds of files to be analyzed (DOORS Modules, 

Word, Excel, FrameMaker files, UML tool files, etc.), 

 an analysis interface in coverage mode, impact analysis mode and Graphic view 

mode, 

 a filter editor for processing analysis results, 

 a version editor to detect and save requirements changes. 

In addition, RG provides for advanced users: 

 a type editor for defining project traceability elements, 

 a template editor for generated documents. 
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Gateway 1.0 – Build 1357 

Initial Release of RG. 

Supports Rhapsody 5.2 and Rhapsody 6.0. 

 

Provided Interfaces: 

Code: 

 Code: Parsing of .c and .h files 

 C Code: Semantic analysis of C code, with presentation of functions 

 

Office: 

 Excel: Analysis of Excel files (Excel 2000, XP, 2003) 

 Excel with column numbers: Analysis of Excel files taking into account columns 

numbering. (Excel 2000, XP, 2003) 

 FrameMaker: FrameMaker files 

 FrameBook: FrameMaker books 

 Interleaf: Analysis of Interleaf documents 

 Acrobat PDF: Analysis of PDF files 

 PowerPoint: Analysis of Powerpoint slide shows, (Powerpoint 2000, XP, 2003) 

 Text: Analysis of ASCII files 

 Word: Analysis of Word files (Word 2000, XP, 2003) 

 WordXML: Analysis of XML files (Word2003) 

 

Requirement Tools: 

 Doors: Analysis of Doors modules -see the Coupling Doors.pdf note (Doors 6.0, 

7.0, 7.1) 

 Doors-Advanced: Advanced analysis of Doors modules - see the 

CouplingDoors.pdf note (Doors 6.0, 7.0, 7.1) 

 RequisitePro: Interface with RequisitePro - see the Coupling ReqPro.pdf note 

(RequisitePro 2003) 
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UML: 

 Rhapsody: Interface between the Gateway and Rhapsody 
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Gateway 1.0 – Build 1396 

Release of RG for Rhapsody 6.0 MR1. 

Supports Rhapsody 5.2 and Rhapsody 6.0 and 6.0 MR1. 

 

Improved feature: 

Access to a document using HTTP has been improved. With the previous build, the user 

was supposed to manually configure Proxy and Server. 

With the Build 1396, this configuration is automated.
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Gateway 1.0 MR2 – Build 618 

Release of RG for Rhapsody 6.0 MR2. 

Improvements of the DOORS interface 
The DOORS interface has been improved to support the following features: 

 Successive uploads are now performed without changing the DOORS objectIDs, 

 Rhapsody Tags and DOORS Attributes are fully managed, 

 Rhapsody Description fields are now inserted in DOORS also for diagrams. 

Changes in the Main Window 

Features for collaborative work 

Restricted access to project configuration 

User (or project manager) can now define a restricted access for the customization of the 

project. 

The Options editor (Tools > Options) can be used to define a password. 

Access to project configuration is granted only if the Password is correct. 

Management of concurrent access 

In addition to the restricted access (password) capability, we added the management of 

concurrent access to the project configuration files (Project, Types, Filters, Options): 

The first user can access to the project configuration. Password can be requested for this. 

If another user wants to access the configuration window, and if the first user still has this 

window opened, the second user has the following options: 

[Read-Only] gives an access to the project configuration windows, but no change is 

allowed. 
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[Notify] gives an access to the project configuration windows, but no change is allowed. In 
addition, when the first user closes the configuration window, the other user will receive 

the notification. 

Display of requirement types and reference types 

Gateway allows you to define several kinds of requirements, attributes, sections, 

references,… 

Gateway 1.1 now displays this information in the main window. 

‘Reload all’ action 

A new menu item Reload all (shortcut = [Ctrl]+[F5]) forces Gateway to re-analyze all the 

project elements and to re-build the analysis results. 

This action is equivalent to what was performed by pressing [Shift] before selecting the 

Reload menu item in previous releases. 

‘Messages’ tab 

The ‘Messages’ tab or Gateway 1.0 has been replaced by a log file which can be accessed 

using the [View log file] button in the Options editor. 

Changes in the Configuration windows 

Project Editor 

Improved HTTP access 

Access to a document using HTTP has been improved. With the previous release, the user 

was supposed to manually configure Proxy and Server. 

With Gateway 1.1, this configuration is automated: Gateway re-uses the Microsoft 

Windows definition of ‘Internet Options’ by the user (Configuration panel > Internet 

Options > Connections tab > LAN parameters…) 

Dropdown list for variable values 

Some types of analysis applied to a document in the project configuration may need 

definition of complementary variables. 

Some variables are filled dynamically during the selection of the File or Directory, or 

captured automatically from the installed configuration. Other variables have to be defined 

by the user, i.e.: 
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 ‘Language’, for Rhapsody UML (C, C++, Ada…) 

 ‘Diagrams Capture’ for Word, Rhapsody, Simulink,… (Yes / No) 

 … 

Now these Values are proposed in a dropdown list. 

Types Editor 

Improved Analysis of multiple Word files 

A new Multi Word type is now available. 

The Code converter was already has the capability to browse directories and present you a 

sub-directories and files hierarchy. 

The filters field in the advanced properties of the type has already the capability to analyze 

several documents (Word or others) but was presenting them as merged in a single large 

document. 

The new Multi Word type gives you a very powerful view of several Word documents in 

a directory with subdirectories. User can select this type and apply it to a document in the 

Project Editor, then is has to select the proper directory (field File or Directory). 

The analysis presents the directory, with subdirectories if any, then each document in 

these directories is presented individually. 

Access to the Regular Expression Tester 

In the Types Editor, the button opening the regular expression tester has been added for 

Text elements: 

Drag & Drop between types 

Drag & Drop capabilities have been improved to facilitate type customization. User can 
drag & drop elements from a default or customized type to another. Keeping the [Ctrl] key 

pressed during this operation duplicates the selected object instead of just moving it.  

Filters Editor 

A Comment tab has been added in the Filters editor. It allows you to fully describe the 
actions performed by the filter. These comments can of course be included in a generated 

document. 
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Snapshots Editor 

Increased detection of changes concerning references 

Changes in references are now presented in the Snapshots Editor. 

Options Editor 

Password 

A ‘Password’ field has been added, as already described for project protection. 

Access to the log file 

The ‘Debug’ option and the Messages tab of the main window have been replaced by a 

log file, which can be accessed by clicking [View log file] in the Options editor. The log 

file log.txt is saved in the project directory, the menu item File > Open Project 

Directory can be used in this case. 

Reports Generation 
The reports that can be generated by Gateway are now organized with a hierarchy. 

Default document templates are provided under a menu Library. 

Document templates specific to a given project are presented in other menus, for example 

Project Docs in the screenshot below. 

Support of Chinese and Japanese documents 
Gateway can now analyse and present requirements and traceability information contained 

in Chinese or Japanese documents.
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Gateway 1.1 – Build 742 

Release of RG for Rhapsody 6.1. 

Simulink Interface 
Gateway now includes a Simulink type allowing to analyze Simulink models and to link 

them with work performed in Rhapsody. 

This interface comes with a Simulink example and a coupling note. 

IMPORTANT 

This interface needs a license “feature”: If you got Gateway before 1.1 release, 

please contact IBM Support Team to upgrade your license key. 

Gateway files can be managed using Rhapsody CM 
capabilities 

Gateway files are now stored under the _rpy subdirectory of the Rhapsody project. 

They can be managed as “controlled files” in order to get benefits from Rhapsody 

configuration management capabilities. 

Option “1 module per package” for DOORS 
The Doors export window now contains an option which leads Gateway to create 1 Doors 

module for each Rhapsody package during the export. 

Support of SysML and DoDAF Profiles 
Gateway supports Rhapsody 6.1 extended capabilities for SysML, DoDAF and other 

profiles. 2 dedicated types of analysis are now available: Rhapsody SysML and Rhapsody 

DoDAF. 
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Improved management of requirements creation 
Management of requirements created in Rhapsody by Gateway has been improved: 

 To allow selection of the specifications document containing requirements to 

create, 

 To define the location of the created requirements package. 

Improved Documentation & Examples 
User Manual has been split in 2 documents: 

A User Manual containing the information for operational use of Gateway on projects: 

project definition, notions and concepts, ratio calculations,… This document is organized 

as a reference manual. 

A Customization Guide, for advanced users and/or internal support teams, explaining how 

to customize Gateway types in order to provide users with predefined types supporting the 

Corporate standards for requirements traceability. This document is organized as a step by 

step tutorial, with direct links to animated demos and targeted examples. 

These documents are located in <install directory>\doc. 

More examples are installed with Gateway: 

Examples showing how Gateway analyzes Word documents, Excel, Powerpoint, 

FrameMaker, Visio, Simulink, Code files,… All these examples are located in <install 

directory>\examples. 

Examples supporting the step by step tutorial (Customization Guide), and animated 

demos. All these examples are sub-directories of the <install directory>\doc 

directory. 

Coupling Notes are explaining all characteristics of Gateway interfaces with third-party 

tools and Rhapsody itself. These notes are located in <install directory>\doc and 

named Coupling <tool>.pdf. 
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Gateway 1.1 – Build 743 

Release of RG for Rhapsody 6.1. 

Extended Rhapsody Types Definitions 
Definition of Rhapsody types of analysis in Gateway was omitting some combination of 

elements in the Rhapsody model. This release solves this issue. 

An additional security level has also been integrated, to allow export of high level 

requirements into Rhapsody even if Gateway displays errors for Rhapsody analysis.
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Gateway 1.1m1 – Build 319 

Release of RG for Rhapsody 6.1 MR1. 

Support of DOORS 8.0 
Gateway supports DOORS 8.0.0 (initial release of DOORS 8.0, not patched). 

At the date of release, Patch 3 for DOORS 8.0 is not supported. 

Gateway still complies with DOORS 7.1 and DOORS 6. 

Support of new Rhapsody requirements definition 
Rhapsody requirements can be defined using ID and Specification fields, in addition of 

the already existing Name and Description. 

Gateway is modified to use these fields as follows: 

Requirement ID captured by Gateway goes to the Rhapsody ID field for requirement, 

Requirement Text captured by Gateway goes to the Rhapsody Specification field for 

requirement 

Display text defined for the captured requirement goes to the Rhapsody Name for 
requirement: if Display text in Gateway is the ID (Display Text field left empty), both 

Name and ID fields in Rhapsody will contain the ID info 

For Rhapsody elements (Requirements created from Rhapsody,…), the Specification field 

is now captured instead of the Description one. 

Automatic allocation of Rhapsody type 
From a Rhapsody project, first launch of Gateway will automatically create a Gateway 

project and will automatically allocate the type of analysis: 

 RhapsodySysML for a SysML project 

 RhapsodyDoDAF for a DoDAF project 

 Rhapsody for other projects 
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Detection of ‘moved’ elements 
Gateway was already showing Deleted, Added and Modified elements between 

successive analyses. 

Gateway now detects and presents Moved objects, when objects have been relocated in 

their browser tree. 

Change concerning of DOORS ‘in-links’ 
Gateway was previously forcing deletion of in-links in order to allow deletion of objects 

in DOORS during the synchronisation (upload) action. 

This feature has been modified: The synchronisation stops, and information window 

appears, when Gateway tries to delete a DOORS object with in-link. The in-link has to be 

deleted in DOORS before running a new synchronisation. 

Word-SysML example 
The example used to demonstrate requirements management between Word requirements 

and a SysML model is now included in the package (Samples subdirectory). 

Change in initial project configuration 
The initial configuration created automatically from a brand new Rhapsody project was 
integrating a DOORS ‘document’, introducing confusing DOORS login windows even if 

DOORS was not installed. This has been changed: now Gateway creates only a project 

including the Rhapsody model.
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Gateway 1.1m1 – Build 335 

Release of RG for Rhapsody 6.1 MR2. 

Support of DOORS 8.0.5 
Gateway supports DOORS 8.0.5. 

DOORS 8.0 releases with previous patches are not supported. 

Gateway still complies with DOORS 7.1 and DOORS 6. 

DOORS Export Window 
Selection of what is to be exported into DOORS (what folders to use, what types to 

export) is now saved and directly available over several sessions. 

Requirements creation into Rhapsody 
Gateway presents a more intuitive error message when package naming captured from the 
requirements tool is not accepted by Rhapsody (it was already existing for problems in 

requirements naming). 

Requirements are no more deleted then re-created when their label (name) is changed. If 

the ID does not change, the requirement previously created in Rhapsody is just updated. 

Gateway reports a “modified requirement” even if only a tag value has been changed. 

Analysis of Rhapsody models 
Improvements for better support of DoDAF and SysML models.
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Gateway 1.2 – Build 343 

Release of RG for Rhapsody 6.2. 

Support of DOORS 8.0.6 
Gateway supports DOORS 8.0.6. 

DOORS 8.0 releases with previous patches are not supported. 

Gateway still complies with DOORS 7.1 and DOORS 6. 

Lower rights needed for DOORS modules 
The Gateway users no more need to have modification rights on the DOORS module 

containing requirements. Read access rights are only requested. 

Analysis of Rhapsody models 
Improvements for better support of DoDAF and SysML models.
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Gateway 1.3 – Build 168 

Release of RG for Rhapsody 7.0 & 7.0 MR1. 

Support of DOORS 8.1 
Gateway supports DOORS 8.1. 

Gateway still complies with DOORS 8.0.6, DOORS 7.1 and DOORS 6. 

Performances Improvement 
Rhapsody Gateway now uses a DLL based solution to get information from Rhapsody. 

Analysis time is dramatically reduced. 

Documentation Improvement 
The documentation (User’s Manual, Customization Guide) has been entirely reviewed, 

and a Getting Started document is now available. 

Navigation from DOORS to Rhapsody 
Rhapsody Gateway install a feature in the RG menu in DOORS that allows direct 

navigation from DOORS to Rhapsody, if the DOORS object is an image of a Rhapsody 

object created Gateway. 

Support of the Functional C profile 
A new type “Rhapsody Functional C” has been added to support the FunctionalC profile.
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Gateway 1.3 – Build 175 

Release of RG for Rhapsody 7.0 MR2 & 7.0 MR3. 

Support of the AUTOSAR profile 
A new AUTOSAR type has been added to support the Rhapsody AUTOSAR profile.
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Gateway 1.4 – Build 83 

Release of RG for Rhapsody 7.1. 

Global Improvements 

Marks extend the scope of requirements change management, comments… 

 You can use Marks to manage requirements changes and impact analysis, or to 

quickly analyze input documents: 

 Automatic and persistent highlight of modifications 

 Automatic highlight of search results 

 Creating your own marks 

 Using Marks in Filters 

DOORS Analysis 

 You can now manage in the project configuration DOORS requirements modules 

for which you only have “Read” access rights. 

 You can now specify the DOORS Baseline you want to analyze. 

 You can now specify the DOORS Server you want to use, thanks to a new 

variable. 

Extended management of references to consider the source document 

 References capabilities have been extended to handle some ambiguities on 

requirement IDs: Rhapsody Gateway can now distinguish between references to 

requirement with the same IDs if user also indicates the name of the document 

containing the requirement (I.e. Covers:REQ1(SRS1) vs Covers:REQ1(SRS2)). 

Creation of traceability information within Rhapsody Gateway 

You can use the new Types for added element if you want to provide project users with 

advanced capabilities of information creation from Rhapsody Gateway. 

 Creation of a Type for Added elements 
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 Declaration of requirements you want to modify 

 Include Types for added elements in your project configuration 

 Add information to the project analysis results 

Reports Generation 

 Tables can now be adapted dynamically depending on the number of documents 

you select for reports generation, 

 The EXCEL format is now available for Generation 

 Direct access to the Snapshots information 

 The groups of documents can be renamed in the Reports Editor. 

Improvements of the Requirements Detail view 
 Columns can be resized, moved, 

 You can sort the results using the attribute values, the IDs,… by clicking the 

column headers, 

 You can copy-paste attribute values from this view, 

 The Requirement Details view supports management of attributes added from 

Rhapsody Gateway through Types for Added Elements capabilities. 

 In the Requirement Details view, you can re-sort the requirements in the same 

way they are captured from the source document, by using the new “Sort by 

default” menu item. 

 A new “Added text” pane allows you to add some text to the requirement text 

captured from the document. To activate this feature, your document is supposed 

to be declared as “modifiable”, that means you need to associate a modification 

document with a type for added element.  

 You can re-sort the requirements in the same way they are captured from the 

source document, by using the new “Sort by default” menu item. 

Improvements of the Graphical view 
 The Graphical view now displays links (in addition to references) 

 Documents can be easily resized and re-positioned, 

 Document trees can be expanded or collapsed, 

 If you defined Types for Added Elements, you can add any kind of reference 

(coverage links) or links from the Graphical view 
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 … 

Creation of a new tagging feature 
This feature allows identifying requirements in a Word document where the requirements 

have no explicit IDs. This new tagging feature also manages iterations. 

Update of the AUTOSAR profile 
An update of the existing AUTOSAR type has been added to support the Rhapsody new 

AUTOSAR profile. 

Support of the Testing profile 
A new Testing type has been added to support the Rhapsody Testing profile.
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RG 1.4 – Build 137w32 - 138x 

Release of RG for Rhapsody 7.1.1 & MR1 (Windows & Linux). 

Update of the AUTOSAR profile 
The AUTOSAR type has been updated according to Rhapsody 7.1.1. 

Support of DOORS 8.2 
Gateway supports DOORS 8.2. 

Gateway still complies with DOORS 8.x, DOORS 7.1 and DOORS 6. 

CaliberRM Interface 
Gateway now includes a CaliberRM type allowing to capture requirements from 

CaliberRM and to link them with Rhapsody design. 

This interface comes with a CaliberRM example and a coupling note. 

IMPORTANT 

This interface needs a license “feature”: If you got Gateway before 1.4 release, 

please contact IBM Support Team to upgrade your license key. 

Rhapsody Gateway Limitations (LINUX) 
Gateway release on Linux does not support: 

Capture diagram option for Rhapsody models. 

Navigation to Doors option. 

 

We will do our best to add those features in the following MRs.
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RG 1.4m1 – Build 179w32 - 
180x 

Release of RG for Rhapsody 7.1.1 MR2 (Windows & Linux). 

Support of DOORS 8.3 
Gateway supports DOORS 8.3. 

Gateway still complies with DOORS 8.x, DOORS 7.x and DOORS 6.
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RG 1.5 – Build 581w32 - 580x 

Global Improvements 

Undo Redo Capability 

It is now possible to undo and redo edition in RG project creation. You can cancel or re-

do actions on element editions (Attributes, Reference Attributes, Coverage links creation 

…). 

 

Those new features are accessible from the Menu: Edit > Undo/Redo. 

You can also use keyboard shortcut:  

Undo: <Ctrl> + <Z> 

Redo: <Ctrl> + <Y> 

Folder: Internal Coverage Link 

Even if it is better to consider a folder as a package of requirement that belong to the same 
project hierarchy level, for some corner cases it is useful to add coverage links inside a 

Folder. This feature is directly accessible from the project configuration window. 
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Multi-User Enhancement 

The control access on Rhapsody Gateway project edition is now handled separately on 

each of the following activity: 

 Project Configuration Edition 

 Types of Analysis Customization 

 Filters Edition 

 Marks creations 

 Added Information such as: 

 Traceability Data 

 Attributes 

 Added Text, Comments… 

 Modification Files Edition 

Add Reference Attributes in the Graphical View 

It is now possible to add reference attributes in Rhapsody Gateway Graphical View. 

 

You can specify and add reference attributes by following these steps: 

1. Select the reference in the graphical view. 

2. Right click in the Reference Attributes box. 

3. Specify a valuable or Boolean Attribute. 

4. Add a reference attribute. 

 
 

Requirement Hierarchy 

It is now possible to create a hierarchy of requirements. To handle such hierarchy you 

have two different alternatives: 

1. Use the End regular expression field in the requirement type customization view. 
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2. Create requirement element hierarchy in the type of analysis as it shown in the 

following picture. 

You can specify accurate rules for coverage calculation depending on user choice. 

 
 

See also: \examples\Use Cases\Requirement Hierarchy. 

HTML Document Generation 

We changed the CSS (Cascaded Style Sheet) associated to default html template. Feel free 

to create your own one for improving your final HTML report. 

Zoom In and Zoom Out 

It is now possible to zoom in and out the project configuration view and all the captured 

diagrams. 

You can change the diagrams and project configuration size by following these steps: 

1. Put the pointer into the diagram zone. 

2. Hold <Ctrl> key. 

3. Use the mouse scroll button. 

 

It is still possible to perform this action on the Graphical View for impact analysis. 

Picture Handling 

RG is now able to handle diagram and images from PNG file format. It means that you are 

now able to capture PNG, WMF, EMF (Only available for Windows), SVG, and BMP. 
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Add Several Config Directories 

It is now possible to add several config directories in order to add customized data as 

Types of analysis, Doc templates, Doc reports, Otscript files, … 

 

You can add those configuration directories by following those steps: 

1. Create your own config directory with the same sub-directory hierarchy that in 

the original Config directory. 

 
 

2. Edit RG.ini file by adding the new config directory path as specified in the 

picture below: 

 
 

3. Re-launch the tool. 

Re-order Attributes   

It is now possible to reorder the different values in the Attributes Values tab. To reorder 

the attributes values you can use the Up and Down arrows like depicted just below: 

 
 

Duplicate Filters 

Reuse existing filters as a starting template of a filter edition is now possible. To use this 

functionality go into the Filter Edition Tag and right click on the filter you want to 

duplicate as describe in the picture just below: 
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Interfaces Improvement 

Rhapsody Interface 

Find high level requirement in Rhapsody 

It is now possible from RG to locate directly in the Rhapsody model a previously 

imported Requirement just by using the “Find high level requirement in Rhapsody” in the 

Tools Menu Options. 

Requirement synchronization enhancement 

It is now possible to customize requirements synchronization with the Rhapsody model by 

enabling options located in the Add high level Requirements/Advanced tab Menu. 

 
 

See Coupling Rhapsody Manual. 
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Considering Other Profiles 

It is now possible to automatically create Rhapsody Types of analysis according to users 

profiles. 

See Coupling Rhapsody Manual. 

XML Type Analysis 

Rhapsody Models are now analyzed with an XML based type of analysis. 

 
 

EXCEL Interface  

Excel Document Generation 

It is now possible to select the location of the content that is generated by RG in the excel 

document template. By default the location of the start of the generated data is cell A1. 

 

You can change this location by following these steps: 

1. In Excel select Insert > Name > Define… 

2. Select <START_REPORT> name 

3. Set the new Cell Value 

4. Select File > Save 
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Excel Spreadsheet 

It is now possible to specify several spreadsheets for an Excel document analysis. 

 
 

Word Interface 

It is now possible to specify several options (variables) on Word document analysis. 

 

You can enable or disable options value in the project configuration view. 

 
 

 With images option will give you the capability to capture images in Word 

document. 

 With Character styles option will convert lines that are using character styles. 

 With Bookmarks option will convert the bookmarks content. 

 With Annotations option will convert annotations content. 

 One Cell Per Line option gives you the choice to add a carriage return between 

each column of a table. 

DOORS Interface  

Support of DOORS 8.1, 8.2 and 8.3. 

Performances have been improved between DOORS and Rhapsody Gateway. 
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REQUISITE PRO Interface 

It is now possible to send back elements to RequistePro by using a dedicated exportation 

window. 

 

This option is accessible from the Tools > Export document to RequisitePro menu: 

 
 

As a result you will have to add information in the Export document to reqpro window: 

1. Enter your login and password to access the RequisitePro database. 

2. Select the targeted Package or create a new one in your RequisitePro Project. 

3. Specify RequisitePro requirement Prefix. 

4. Select element categories that has to be exported (Default: All). 

5. Click on Export Button 

FRAMEMAKER 8 Support 

RG is now supporting Framemaker 8. 

Documentation Improvements 

Customization Guide 

A new section has been added for customization of report template. 

See Customization Guide. 

RG Coupling Document 

This document has been updated significantly for Rhapsody ~ DOORS Synchronization 

use cases.
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RG 1.5 – Build 664w32 - 665x 

Release of RG for Rhapsody 7.2 MR1 (Windows & Linux). 

DOORS Interface 
Improvements on UNICODE support (Chinese, Japanese, Korean, Russian, ...). 

Internal Gateway Modification Files 
A new format for added modification files has been introduced in RG 1.5. 

Added element modification files from RG 1.4 and earlier need to be upgraded. 

 

If you encounter the issue presented in the following dialog: 

 
 

Please contact the IBM Support Team to obtain an upgrade procedure.
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RG 1.6 – Build 339w32 - 340x 

Release of RG for Rhapsody 7.3 (Windows & Linux). 

Documentation 
Important document updates: 

 Word and DOORS tutorials updated, 

 Manuals and Coupling notes updated, 

 Introduction of the “Best Practices” guide. 

Rhapsody Interface 
UNICODE support now extended to elements labels and specification field. 

Important fixes concerning CKTJ (Chinese, Japanese, Korean,…) support. 

 

Support of Rhapsody projects lists. 

 

Detailed error reporting in Add high level requirements feature. 

 

New options introduced: 

 With stereotypes applied: enables output of all stereotypes in the intermediate file. 

 Stereotype selection for Dependencies in ‘Add High Level Requirements’ 

advanced tab. 

MODAF Profile 

New Rhapsody MODAF type introduced to support analysis of models with MODAF 

profile. 
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DOORS Interface 
Support of DOORS 9.0. 

Gateway still complies with DOORS 6.1, DOORS 7.1 and DOORS 8.x. 

 

The Doors type based on Text analysis has limited functionalities and does not include the 

UNICODE enhancements. 

Usage of XML types such as Doors Basic or Doors Advanced types is encouraged.
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RG 1.6 – Build 352w32 - 354x 

Release of RG for Rhapsody 7.3 MR1 (Windows & Linux). 

This maintenance release contains important fixes on the Rhapsody Gateway kernel, 

Rhapsody and DOORS coupling. 

Gateway Kernel 
A reload Rhapsody model issue related to GUID support and inverse cover links has been 

fixed. 

 

Restoration of multiple choices settings for documents was fixed (such as Sources and 

Types unchecked in Export to DOORS dialog). 

 

The following internal errors were fixed: 

 10136 

 10193 

Rhapsody Interface 
Support of target package with a label different to the name has been added to the Add 

high level requirements functionality. 

DOORS Interface 
Error handling in export to DOORS has been improved.
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RG 1.7 – Build 18w32 - 19x 

Release of RG for Rhapsody 7.4 (Windows & Linux). 

Red Hat Enterprise Linux 5 
RG 1.7 is now supported on Red Hat Enterprise Linux 5. 

Eclipse Integration 
RG can now be invoked from the Eclipse Integration of the Rhapsody Modeler. 

Rhapsody Interface 
A new Rhapsody tab has been added the option editor. 

 
 

The new ‘Label Mode’ allows the user to control whether element name or label of 

Rhapsody element should be imported into Gateway. 

DOORS Interface 
Support of DOORS 9.1. 

Gateway still complies with DOORS 6.1, DOORS 7.1, DOORS 8.x and DOORS 9.0. 

 

Performance of DOORS module import has been improved on links to other modules 

reading.
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RG 1.7 – Build 44w32 - 45x 

Release of RG for Rhapsody 7.4 MR1 (Windows & Linux). 

International Support 
Rhapsody Gateway can now be installed in a directory having Japanese or other eastern 

characters. 

Kernel 
Fixed loss of consecutive carriage returns problem. This was causing some requirements 

to be permanently modified with Add high level requirements to Rhapsody. 

XML type editor was fixed to not corrupt the types file when a bad attribute name is 

entered. 

Documentation 
Coupling Rhapsody and Coupling DOORS have been updated. 

Customization Guide documentation now describes the available variables in Display 

fields. 



RG 1.7 – Build 44w32 - 45x 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

47 

Rhapsody Interface 
The type Rhapsody TestingProfile Focused is provided as a dedicated solution to only 

analyze and export tests related information from an UML model. 

 
 

Add high level requirements to Rhapsody feature received some modifications: 

 Created stereotypes are now applicable to Requirement, Package and Dependency 

instead of ModelElement, 

 The stereotype of Dependencies created by the Gateway is synchronized 

according to the Add high level requirements configuration. 

DOORS Interface 
The links previously Exported to DOORS are no longer duplicated as inverse cover link 

(IsCoveredBy) when using the Doors Advanced type. 

 
 

The Export process has been improved to delete old links before removing the old 

elements in order to avoid errors. 
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Navigation from DOORS has been improved. A hidden attribute ObjectID was added to 

the Doors Advanced type in order to enable the inverse navigation. 
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RG 7.5 – Build 560w32 - 561x 

Release of RG for Rhapsody 7.5 (Windows & Linux). 

Usability Improvements 

Find Previous/Next 

It is now possible to jump to forward and backward elements during Find operation. Two 

dedicated “Next” and “Previous” search buttons are available in the Find Window. 

 

Those new features are accessible from the Menu: Edit > Find/Find Next/Find Previous. 

 
 

You can also use the following keyboard shortcuts: 

 Find: <Ctrl> + <F> 

 Next: <F3> 

 Previous: <Shift> + <F3> 

Marks enhancements 

It is now possible to jump from one Mark to another in both backward and forward 

directions. You can use contextual menu as it is describe in the picture just below or by 

using the following keyboard shortcuts: 

 Next: <F2> 
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 Previous: <Shift> + <F2> 

 
 

To avoid Rhapsody Gateway users to spend too much time and effort in the painful task of 
removing one by one hierarchical marks we added a new capability of removing a mark 

and all their children in one click, thanks to “Remove marks recursively” option. 

Filters enhancements 

Rhapsody Gateway enhances filtering capabilities by increasing elements number where 
users can create conditions on. All those new elements are accessible from the Filter editor 

window by adding specific conditions on elements like: 

 Single Requirement Type 

 Single Reference Type 

 Enumerated attribute values 

 
 

Always on Top 

It is now possible to put Rhapsody Gateway on top of all the other applications on your 
desktop. As a result it is a question of choice to use Rhapsody Gateway as your project 

monitoring tool during your everyday work and make it always visible and quickly 

accessible. Rhapsody Gateway users can enable/disable “always on top” option in the 

option tab accessible from the main project configuration window. 
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Ask for Reloading 

Remember how it was painful to see this popup window appearing asking you if you 
would like to reanalyze a document as soon as a single element as been modified. Thanks 

to Rhapsody Gateway it is now possible to block this popup window. As a result a 

dedicated icon will inform users if a document is up to date or not. This document analysis 

can be done later on user demand with a simple reload action on the document. 

 
 

Snapshots comparison enhancements 

A snapshot comparison feature is able to give you in one click all the differences between 

at least two project milestones on requirement modifications (and their attributes) and 
traceability data. You can now also see the differences on reference attributes and hide 

hidden attributes form the analysis. 

DOORS Interface 
Support of DOORS 9.2. 

Gateway still complies with DOORS 6.1, DOORS 7.1, DOORS 8.x and DOORS 9.x. 

DOORS Type Builder Wizard 

A new DOORS Type builder wizard was introduced in the Rhapsody Gateway Project 

editor. 
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It can be invoked from the File menu when you want to import a new DOORS document: 

 
 

It can be also invoked on an existing DOORS document using the pop-up menu in the 

project graph: 

 
 

This wizard allows customization of DOORS types (XML ones) based on existing and 

recommended analysis features applied on attributes from DOORS objects. 

 
 



RG 7.5 – Build 560w32 - 561x 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

53 

Doors Full Hierarchy Type 

A new DOORS type of analysis is available: 

 
 

This new type is suitable when the DOORS module analyzed doesn’t allow a clear 
identification of Sections and Requirements. The whole DOORS Object hierarchy is 

captured as a Requirement hierarchy in Rhapsody Gateway: 

 
 

Navigate to exported Element in DOORS 

 
 

Export to DOORS improvements 

The Export to DOORS has now a tabbed interface that separates usual settings from 

advanced settings. 
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You can know specify a particular server directly in the Export to DOORS dialog. 

 

The filtering capability of the export was improved so you can know send only specific 

element types to DOORS: 

 
 

The highlighted option changes the filtering behavior and shall be used when you want to 

send only some kind of element types such as above. 

 
 

The other option ‘Do not maintain element location’ switches off the reordering of 
elements inside the exported module. So you will be able to place the exported elements 
anywhere you want inside the module and keep them synchronized. This feature is only 

available with documents that support GUIDs such as Rhapsody models. 
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Rhapsody interface 

Add high level requirements 

The Add high level requirements dialog has been also changed into tabbed interface. 

 
 

All specific settings are accessible in the Advanced tab: 
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Rhapsody / DOORS Bidirectional Synchronization 
It is now possible to keep model elements and DOORS high level requirements 

synchronized on both sides using the Rhapsody / DOORS Synchronization. This is 
currently limited to one Rhapsody model and several DOORS documents (bidirectional 

synchronization) or other documents such as Word (unidirectional from source to 

Rhapsody). 

This feature concentrates both Rhapsody and DOORS export settings. Once everything is 

configured, it runs all operation consecutively with a minimum of user interactions. 

 
 

Enabling Features 

The first time you run this setup mode, you will see the available features for 

synchronization which are including the usual operations Add high level requirements to 

Rhapsody and Export to DOORS. 

The Rhapsody / DOORS Synchronization now introduces the reverse synchronization 

operations and allows integration of DiffMerge which is able to take automatically some 

decisions. 

 
 

 



 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

57 

 

RG 7.5 – Build 570w32 - 571x 

Release of RG for Rhapsody 7.5.0.1 (Windows & Linux). 

This is a FixPack version of Rhapsody Gateway 7.5. 

DOORS interface 
The export of diagrams modified in Rhapsody to DOORS has been fixed. 

Rhapsody interface 

Add high level requirements 

Preserve Hierarchy: The translation of section names to package names was improved 

(better support of ADA language package names). 

Exception Handling: Now provides a better messaging when target packages are read-

only or unloaded.
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RG 7.5.1 – Build 610w32 - 609x 

Release of RG for Rhapsody 7.5.1 (Windows & Linux). 

Gateway Lite Mode 
NEW: Rhapsody Helpers are available to invoke directly the Export to DOORS or 

Requisite Pro. 

This feature is not available for Linux. 

 
 

Internationalization 
Japanese translation of the Gateway interface is now available. 
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Gateway fixes 
Text exclusion regular expression behavior. 

Coverage statistics with Analysis filter (Management view). 

Use of the Text Display field. 

Rhapsody interface 

TestingProfile 

Test Objective is now treated as coverage link. Capture of the Verdict tag. 
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RG 7.5.1 – Build 627w32 - 628x 

Release of RG for Rhapsody 7.5.1 Fix Pack 1 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody Gateway kernel, 

Rhapsody and DOORS interfaces. 

Rhapsody interface 
New option to control the scope of the requirements synchronization using the Add high 

level requirements feature. 

 

 

When this option is not checked, the Add high level requirements feature is able to update 
or add the deleted mark on requirements that were moved outside of the target package. 

This behavior exists since Gateway for Rhapsody 7.1.1 MR3 and 7.2. 

This option may be unchecked when the synchronization must be performed locally. This 

was the behavior of Gateway versions prior to 7.1.1. 

The local synchronization behavior might be useful when synchronizing the documents 

one by one. 

DOORS interface 
Important fix on exportation of Rhapsody diagrams to DOORS. 

Important fix related to the option “Keep children of filtered elements”. 
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RG 7.5.2 – Build 2788w32 – 
2789x 

Release of RG for Rhapsody 7.5.2 (Windows & Linux). 

Global Improvements 

Management View Revamped 

Gateway now includes a brand new Management View where managers can quickly 

check the current status of the different project phases. Traceability achievements, 

requirement errors and a global Quality metric give an instant and easy to see project 

progress and overall quality metrics with project progress and metrics indicators. 
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Project Configuration – Cover Links 

It is now possible to specify cover link name and category in the project configuration 
view. Users can now choose if project links are traceability links or dependency links 

resulting in different coverage calculation. 

  
 

Rules Manager 

Project Managers can not specify which rules will be applied or not on each Gateway 
project thanks to the new rules management cockpit. This cockpit, accessible from the 

project configuration tab, gives the ability to enable/disable existing rules and to create 

new rules from scratch with a simple and intuitive rules editor. 
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Link Details View 

As soon as we are talking about traceability, links management is a very important task to 
deal with. Gateway offers a new link details view where users can create, edit and analyze 

traceability and dependencies between project artifacts. 

  
 

Suspect Link Management 

Gateway users can now choose if they would like to consider existing traceability data as 

suspicious Links as soon as changes occurred on covered requirements. 
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XML Type Tester 

Analysis type customization is sometimes a difficult to handle. As a result, Gateway offers 
a new XML Type of analysis Tester that gives the ability for users to test their XML based 

type of analysis prior to applying them to any real document in the project. This Tester is 

working as the existing PERL Regular Expression Tester for Textual Based Type of 

Analysis. 

  
 

Performance Improvements 

XML Capture 

Gateway now includes a new XML capture process that improves the performance of the 

XML capture step and the stability of the Gateway tool especially when huge XML files 

are analyzed. This improvement is profitable for both DOORS and Rhapsody documents. 

DOORS 

The DOORS conversion to XML performance was drastically improved especially when 

the module contains an important volume of texts and attributes values. 
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Rhapsody Interface 

Rhapsody C# language support 

Rhapsody Gateway now provides the Rhapsody C# type for C#language support. 

Add high level requirements 

The behavior of “Create Dependencies” option was improved. Now it removes the high 

level links that no longer exist. 

Add high level requirements operation provides more debugging information when an 

exception happens. 

DOORS Interface 

Connection Profiles 

It is now possible to setup different server profiles that will be directly accessible for 

import and export operations with the DOORS database. The connection profiles enable 

the multiple DOORS client/server version support in the Gateway without having to 

modify any environment variable or registry setting. 

 

Export to DOORS 

The Export to DOORS dialog now provides the ability to show the “Project View”, you 

can also quickly create a DOORS Folder or Project when you are exporting new Gateway 

documents to DOORS. Additionally, the Options tab now provides new options to 
“Remove the heading number” from the export result. The export to DOORS can also 

create a view that shows the exported attributes. 
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Note 

Export to DOORS is now creating an enumerated attribute in DOORS when the 

values are specified in the Gateway attribute type. Multiple enumerated values can 

be exported to DOORS. 
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Rhapsody / DOORS Bidirectional Synchronization 

Improvements 

Various fixes of the DOORS Attributes and Rhapsody Tags synchronization. 

The synchronization feature now provides a single progression dialog showing the global 

and individual progression of each operation. 

 

Reverse Synchronization of Links 

Rhapsody Gateway is now able to process a reverse synchronization of links defined from 

the mirror of a UML Model exported in DOORS. UML Links must be defined in a 
DOORS module defined by the DOORS Export mapping such as Trace, Dependency, 

Satisfaction, etc… 

This operation is performed when the option “Update model from its DOORS mirror” is 

checked. 

 

This is a reverse operation of Export model to DOORS. The DOORS link module must 
have the same name as a Reference or Link type defined in the Rhapsody type, only 

Dependency links are supported. 

A “Trace” link must have a Requirement type as target since it is mapped to a Reference 

type in Gateway. You may use the “Dependency” module instead for link to other UML 
elements and eventually create another Link type tied to a Rhapsody dependency 

stereotype. 
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Create high level requirements from Rhapsody 

Rhapsody Gateway is now able to create high level requirements in DOORS when they 
are created from the Rhapsody Package tied to the DOORS document. Requirements must 

have the <<fromDoors…>> applied in order to be identified as high level requirements 

instead of UML Requirements. 

This operation is performed when the option “Update high level requirements from 

Rhapsody” is checked. 

 

This is a reverse operation of add high level requirements. Gateway will use the 

specification field as the text of the requirement unless the add high level requirement 

option “Use description field instead of specification” is checked. 
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RG 7.5.2.1 – Build 2802w32 - 
2803x 

Release of RG for Rhapsody 7.5.2.1 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody Gateway kernel, 

Rhapsody and DOORS interfaces. 

Coverage Analysis 
Fixed problem with requirements always considered as covered when they are defined in a 

document with a self-cover link. 

DOORS interface 
Fixed problem with the save button after the Export to DOORS was aborted. This was 

causing a reload problem when the button was activated, it was necessary to reload twice. 

Fixed conversion problem with the old Doors regular expression based type. 

Fixed comparison problem before Export to DOORS that was not detecting some 

movements. 

XML Tester 
Fixed import intermediate file problem when there is picture data in the XML file (such as 

diagrams from DOORS). 

Rhapsody / DOORS Bidirectional Synchronization 
Fixed creation of requirements from Rhapsody using the synchronization feature“Update 
high level requirements from Rhapsody”. This was not working with empty DOORS 

modules. 
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RG 7.5.3 – Build 2958w32 – 
2959x 

Release of RG for Rhapsody 7.5.3 (Windows & Linux). 

Performance Improvements 
Gateway first project loading startup is now faster (about 60% measured on typical 

machine configuration). 

Rhapsody Interface 
Rhapsody model importation now keeps the element ordering under categories when the 

option “Enable Ordering” is activated in Rhapsody. 

AUTOSAR 4.0 Profile 

Rhapsody Gateway now supports the importation of Rhapsody AUTOSAR 4.0 model 

elements. 

MicroC Profile 

Rhapsody Gateway now supports the importation of Rhapsody MicroC model elements. 
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Support of DOORS 9.3 
Gateway supports DOORS 9.3. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and DOORS 9.x. 

DOORS Interface 

Export Improvements 

Now the Export to DOORS maintains the order of sibling elements. 

The UML requirements name are now updated in the module exported to DOORS. 

New term of Package are now exported into individual DOORS modules when the option 

“One module per Package is checked”. 

Conversion of Table objects 

Option “With Table objects” converts the DOORS table rows and cells as XML. 
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Rhapsody / DOORS Bidirectional Synchronization 
Now the Rhapsody / DOORS bidirectional synchronization automatically reloads the 

DOORS document before the process starts. 

Another option named “Reload high level documents after modifications” allows the 

Gateway to reload automatically the DOORS module modified after the synchronization 

process so the changes are immediately visible in the Gateway. 

 

Preserve Hierarchy 

Now the requirements created from Rhapsody using the synchronization feature“Update 

high level requirements from Rhapsody” are added to the DOORS section corresponding 

to the package created with the option “Preserve Hierachy”. 

Note: Once the requirement is created in DOORS, the synchronization feature doesn’t try 

to move to another section when the requirement is moved from one Package to another in 

the Rhapsody Model. 

Reverse Synchronization of Links 

Now the synchronization feature is able to synchronize the links between high level 

requirements from Rhapsody to DOORS with the synchronization feature “Update high 

level requirements from Rhapsody”. 

The option “Create depedencies instead of anchors” must be activated and dependencies 

must have the stereotype <<fromDoors...>>. Gateway will either create a Reference or 
Link according to the other stereotypes and the Add high level requirements 

configuration. 

DOORS Links will be created in a link module that has the same name as the DOORS 

Reference or Link type used. 
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RG 7.5.3.1 – Build 2964w32 – 
2965x 

Release of RG for Rhapsody 7.5.3.1 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody Gateway kernel, 

Rhapsody and DOORS interfaces. 

DOORS Interface 

Option to create new elements at the top of the module 

In previous releases, the Gateway was still trying to export new elements near to other 

elements that were already exported in DOORS. Consequently it may be difficult to 

retrieve the location of the new DOORS objects exported. 

Now the user can change this behavior by activating the option “New elements at the top 

of the module” when the option “Do not maintain elements location” is selected. All new 

elements are created at the top of the module. 
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RG 7.6 – Build 1522w32 – 1523x 

Release of RG for Rhapsody 7.6 (Windows & Linux). 

Rhapsody interface 

New Look and Feel 

Rhapsody icons and types were updated in the Gateway to support the new Rhapsody 

browser look and feel. 

 

NOTE: The Rhapsody browser icons were reorganized in the Gateway installation to 

improve the maintenance and clarity of Rhapsody profiles supported. This must be 

considered if you are using old Rhapsody types with customizations. 
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Multiple Profile Support 

The Rhapsody type generator was improved to support multiple profiles at the same time. 
This type generator can be invoked from the menu “Tools > Generate types for this 

model” when the Rhapsody model is selected in the Gateway. 

 

 

NOTE: Use can configure an additional user config path in the rg.ini file when the 

program files config is read-only : 

[Files] 

Config2=$USERPROFILE\IBM\Rational\Rhapsody\<Version>\Gateway\config 
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Transfer text formatting 

Gateway is now able to insert text of high level requirements with formatting when the 

option “Transfert text formating” in the Add high level requirements dialog. 

 

 

Rich text can be captured from specific document types such as Word when the With 

Richt Text option is activated: 
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User can also configure types to capture table rows and cells (with regular expressions 

only). Then the tables will be part of the rich text. 

 

Navigate to DOORS 

A new Navigate to DOORS menu was added to Rhapsody. It allows to navigate on 

requirements imported from DOORS (like Navigate to Origin) or elements exported to 

DOORS. 
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DOORS Interface 

Export Rhapsody Packages as DOORS Folders 

The checkbox “One module per package” was replaced with “Package layout” option that 

provide an additional choice: “One folder and module per package”. 

 

 

This option will create a hierarchy of DOORS Folder under the Project selected for the 

export. The content of packages will be exported to modules in their respective folders. 
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Export Reference attributes as DOORS Link attributes 

The Export to DOORS now provides the ability to export Reference attributes as DOORS 

Links with the option “Export link attributes”. 

 

Export Links to specific DOORS Link module 

The Export to DOORS dialog now provides the ability to configure the target DOORS 

Link module for all links instead of the Default behavior which is one Link module per 

link type. 

This option is available in the contextual menu of Link types in the Export to DOORS 

dialog. 

 

DOORS Wizard 

The DOORS Wizard is now able to update existing DOORS types and preserve user 

defined customization of fields like Display or Identifier format. 
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ExcelXML and CsvXML 
Rhapsody Gateway is now supporting an ExcelXML and CsvXML conversion. 

The ExcelXML type is easier pattern definition and lower the risk of erroneous extraction 

than the Excel type. 

 

The CsvXML type provides an import dialog that supports different kind of CSV (Comma 

Separated Values) format. See example in Gateway/examples/coupling/Excel. 
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RG 7.6.0.1 – Build 1529w32 – 
1530x 

Release of RG for Rhapsody 7.6.0.1 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody Gateway kernel, 

Rhapsody and DOORS interfaces. 

 

Rhapsody interface 
Improved memory scalability of Add high level requirements and other operations to 

support big Rhapsody models (approximatively 300,000 elements). 

DOORS interface 
Optimized the size of DXL generated during the Export to DOORS operation in order to 
support bigger models (approximately 70,000 elements exported with some Sources 

unchecked). 

Fixed Export to DOORS memory problems related to big diagrams containing bitmap 

pictures. 
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RG 7.6.1 – Build 1869w32 – 
1870x 

Release of RG for Rhapsody 7.6.1 (Windows & Linux). 

Support of DOORS 9.3.0.4 
Gateway supports DOORS 9.3.0.4, except the importation of picture that doesn’t work 

with this particular version when the Windows version is below Windows 7. 

Consequently, you are not able to capture pictures from the Object Text with this DOORS 

version on Windows XP. Additionnaly the export to DOORS will always try to export the 

diagrams if this option is selected. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and DOORS 9.x. 

Support of RequisitePro 7.1.3 
Gateway is compatible with RequisitePro 7.1.3 and previous versions since 2003.06. 

Rhapsody interface 

Add high level requirements into a different Package 

Previously, requirements outside the target package were either not moved (due to global 

sync capability outside the package) or marked as deleted when the option “Update only 

in target package” was selected. 

Now users can add high level requirements into any target package then decide to move 

the requirements later in another package. 

A pop-up appears when the selected Package is different from the one previously used. 
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Add high level requirements with enumerated value on Attributes 

Gateway is now able to set enumerated value on requirement tags in Rhapsody. It is 
necessary to declare the different enumerated values in the attribute type configuration of 

Gateway. 

 

Then the tag appears with an enumeration type in Rhapsody. 
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The enumeration is declared in the same package as the <<from>> stereotype. 

 

DOORS interface 

Rich text support 

User can activate the Rich text support from DOORS by checking the “With Rich Text” 

variable/value on the DOORS document in the project editor: 

 

This option activates the RTF conversion mode for the DOORS Object Text only, the 

corresponding rich text will be captured and shown in the Gateway text panel. 
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Finally you can transfer the rich text of DOORS requirements to Rhapsody using the Add 

high level requirements feature and the Advanced option “Transfer text formatting” 

mentioned in RG 7.6 release notes. 

 

Limitations: The rich text format may not be fully supported. Additionally, Gateway will 

only take modification of raw text into account when Add high level requirements is 

processed. Differences on space characters are also ignored. 
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RG 7.6.1.1 – Build 1873w32 – 
1874x 

Release of RG for Rhapsody 7.6.1.1 (Windows & Linux). 

 

This maintenance release contains various fixes on the DOORS interface and 

synchronization feature. 

Windows 7 installation 
Improved installation for user account without administrator privileges. 

Microsoft Office 2010 
Support of MS Office 2010 is officially announced for MS Word and MS Excel 

documents. 

DOORS interface 
Conversion of DOORS module to XML was fixed. 

Close the DOORS module window before export to DOORS operation in order to prevent 

from potential DOORS crash. 

Rhapsody / DOORS Bidirectional Synchronization 
Fixed reverse synchronization of high level requirements text from Rhapsody to DOORS. 
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RG 7.6.1.2 – Build 1883w32 – 
1884x 

Release of RG for Rhapsody 7.6.1.2 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody Gateway kernel, 

DOORS interface and synchronization feature. 

Support of DOORS 9.4 
Gateway supports DOORS 9.4. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions. 

Regarding Windows XP, see also the special mention in chapter RG 7.6.1 > Support of 

DOORS 9.3.0.4. The same problem appears with subsequent versions until 9.4. 

Picture support on Windows XP is now fixed with DOORS 9.4. 

Rhapsody / DOORS Bidirectional Synchronization 

Reverse synchronization of multiple enumerated value attributes 

Support of enumerated attributes and multiple enumerated attribute values was added for 

Add high level requirements in version 7.6.1. 

Now the reverse operation (Update high level requirements from Rhapsody) supports the 

synchronization of multiple enumerated values from Rhapsody to DOORS as long as the 

attribute type is correctly defined in Gateway with enumerated values declared and “Is 

multi-valued” option is checked. 

Reload DOORS module problem 

Fixed problem with the automatic reload of DOORS requirement modules at the 

beginning of the synchronization process. 
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RG 8.0 – Build 586w32 – 587x 

 

 

Release of RG for Rhapsody 8.0 (Windows & Linux). 

Global Improvements 

Welcome Screen 

Now Gateway provides a Welcome Screen accessible from Rhapsody toolbar. 

 

It is provides quick links to: 

 Open the active Rhapsody project in Gateway, 

 Export the active Rhapsody project to DOORS, 

 Essential documentation, 

 Basic Gateway project example with Rhapsody and Word requirements, 

 Shortcut to Gateway documentation folder. 
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Rich Text Support 

Rich Text Management 

Rhapsody Gateway is now able to process rich text: 

 Display in Rhapsody Gateway GUI 

 

 Import from external tool 

 Enter in Rhapsody Gateway GUI using specific toolbar or shortcuts 

 

 Available for Report Generation 

 Export to external tools 

Text supports rich text properties such as: 

 text colour and background colour 

 bold, italic, underline, strikethrough, superscript, subscript 

 bulleted list and numbered list 

 left, right and center alignments 

 tables 

 pictures 
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 OLE objects 

 

Following interfaces have been upgraded to support rich texts: 

 Word 

 Excel 

 OpenOffice Writer 

 Rhapsody 

 DOORS 

Following features support rich texts too: 

 Tagger 

 

Rhapsody Interface 

Capture model hyperlinks 

Now Gateway is able to capture Hyperlinks as links between elements (when link end is a 

model element) or links to “external requirement”. 

 

It is possible to follow the Hyperlink to another model element using right-click menu > 
Find In The Tree. Other Hyperlinks have external requirements with free text identifier as 

link end, it is only possible to navigate to URL link. 

Delete old high level requirements automatically 

Previously the Add high level requirements feature was marking the requirements with the 

tag “Deleted_At_High_Level” when the same requirement was no longer appearing in the 

documents selected in Add high level requirements configuration. 
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Now it is possible to change this behavior by activating the option “Remove definetely the 

deleted requirements from model”. 
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Mark added or modified high level requirements with a tag 

It is now possible to identify requirements created or modified by Add high level 

requirements feature by activating the option “Mark the modified and added 

requirements”. A tag named “Added_At_High_Level” or “Modified_At_High_Level” 

will be applied accordingly to the operatoin performed. 

 

Specify stereotype for high level requirements and related elements 

It is now possible to select a specific stereotype or new term individually for 

Requirements, Packages, Hyperlinks and Types element created with the Add high level 

requirements feature. The historical stereotype <<fromXXX>> is still added implicitely 

for compatibility reasons. 
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DOORS Interface 

Export external links 

Rhapsody Hyperlinks are divided in two categories: 

1) Regular link when the target is a model element. These links are exported in regular 

DOORS link modules. 

2) External link when target is a free text or UML (also known as “external 

requirement”). These links are exported as DOORS external links. 

 

Remove object with in-links automatically 

Previously, the Export to DOORS did not remove the old elements that were still 
referenced by another module or other DOORS objects that were not recognized by the 

export to DOORS. Now it is possible to force the deletion of object with in-links and a 

warning message is still shown. 
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Rhapsody / DOORS Bidirectional Synchronization 

Reverse synchronization of model element addition/deletion 

It is now possible to create or delete model elements with the reverse synchronization 

operation “Update model from its DOORS mirror”. 

 

Objects created in DOORS must have the following attributes filled: 

 “Element Label” must contain a valid Rhapsody element name 

 “Element Type” must contain a valid Rhapsody Gateway type name according to 

the Rhapsody type being used (Rhapsody, Rhapsody SysML, or other). 

 “Element Guid” must contain a unique and arbitrary value. 

Once the elements are created in Rhapsody, the regular export to DOORS shall be 

performed (as part of the synchronization process for instance). The DOORS object will 

be replaced by other objects corresponding to the elements created in Rhapsody. 
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RG 8.0.1 – Build 592w32 – 593x 

 

 

Release of RG for Rhapsody 8.0.1 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody Gateway kernel, 

Rhapsody and DOORS interface. 

Support of DOORS 9.5 
Gateway supports DOORS 9.5. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions. 

DOORS interface 
Added support of elements moved from one package to another while option “One 

Module per Package” is used. Previously, a message “Can't move elements out of DOORS 
module” was shown. Now, the elements are considered as deleted from the previous 

package and the correspoding objects are created in the other package. 

Fixed incorrect behavior in Export to DOORS while using option “One Module per 

Package and Folder”. 

Improved selection of sources with tri-state checkbox. 
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RG 8.0.2 – Build 602w32 – 604x 

 

 

Release of RG for Rhapsody 8.0.2 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody and DOORS interface. 

Rhapsody interface 

Capture Diagrams 

Now the capture diagram feature is no longuer changing the property 
"General.Graphics.ExportedDiagramScale" of diagrams. The exportation of big diagrams 

was also improved. 

Add high level requirements other languages support 

Add high level requirements feature was updated to support the restriction introduced in 
8.0 for Rhapsody requirement name with Japanese, Chinese, and other languages with 

special character encodings. 

This is only applicable when the application is running under a Japanese, Chinese or other 

specific language operating system. 

Now the Add high level requirements feature may replace some language specific 

characters with compatible ones and may even use Rhapsody autonaming when necessary. 

The Label of Rhapsody requirements is not concerned by this restriction. 

 

Regular browser display 

 

Label Mode browser display 
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RG 8.0.3 – Build 561w32/w64 – 
563x 

Release of RG for Rhapsody 8.0.3 (Windows & Linux). 

 

Global Improvements 

Regular Expression Analysis 

Separators around identifiers are automatically removed to avoid traceability coverage 

errors. 

Internal Types Usage 

By default, internal types are disabled. It is preferable to use Added Element Types. A 

checkbox is available in Options window to reactivate them. 

Attribute types 

Attributes can be computed using OTScript code.  

Attribute parent types can be defined. When this parentship is not respected, errors are 

raised during analysis process. 
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Report Editor 

Copy/paste functions are now available to copy/paste part of Report Model.  

 

 

Report Generation Fields 

Fields can be defined in the Report Model Editor. 

These fields are set using OTScript language. 

They can be used in: 

 Constant texts, 

 Condition, 

 Templates, 

 Other OTScript code.  

They are referenced using ‘$’ sign. 
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Suspicious Links 

A new checkbox Affect Suspicious Link is available in Attributes tab in the types editor to 

indicate that attribute change must affect suspicious link state. 

 

A new dialog allows to manage Suspicious links easily and globally. 
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Snapshot Editor 

In the Snapshot Editor, Gateway shows new and old attribute values.  

 

Find Dialog 
Find dialog has been enhanced in order to specify scope of search. 

 

Filters 
Following graphical information can now be saved in filter: 

 Document positions and sizes in Graphical View 

 Column widths, sort criterion and sort order in Requirement Details. 
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On-the-fly hyperlinks on text field 

Now HTTP, Mail, File and other URL are automatically translated to hyperlinks in the 

Gateway text field so the navigation is now possible. 

Regular Windows and UNIX file adresses are not supported. 

 

Definition of default Text Editor 
Default Text Editor used for edition of text (Text edit tool) can be defined in Option 

Dialog. 

 

Microsoft Office 2013 
Support of MS Office 2013 is officially announced for MS Word and MS Excel 

documents. 



RG 8.0.3 – Build 561w32/w64 – 563x 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

108 

Support of DOORS 9.5.1 
Gateway supports DOORS 9.5.1. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions. 

New Word Converter 
A new Word converter is available to capture richer and bigger contents from Word 

document. 
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Code C# 
Gateway now provides a Code C# type that captures classes and functions from C# code 

files. 
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Rhapsody interface 

Rhapsody 64bits 

Gateway now supports Rhapsody 64bits. 

Arbitrary profiles support 

 Now a pop-up suggests to generate a Rhapsody type for profiles that are not supported 

out-of-the-box the first time a Rhapsody project is opened in Gateway. 

This pop-up appears more frequently since Rhapsody projects often use several profiles 

but Gateway only provides standard Rhapsody types supporting just one profile at a time. 

 

 

 

The Rhapsody type generator is still available afterwards in menu “Tools > Generate types 

for this model” when the Rhapsody document is selected Gateway. 
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Add high level Macro-Requirements 

Gateway add high level requirements feature is now creating Macro-Requirements as 

requirements in Rhapsody. 

User can select a particular stereotype that will be used when Gateway Macro-

Requirements are created as Requirement elements in Rhapsody. 

 



RG 8.0.3 – Build 561w32/w64 – 563x 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

112 

DOORS Interface 

DOORS Wizard special characters 

DOORS Wizard now provides three modes for conditions on attributes. The default mode 
is “Expression” for regular-expressions matching and is still interpreting special 

characters. The new modes “Contains string” and “Exact string” are automatically 

creating appropriate regular-expressions in the DOORS XML type generated. 
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RG 8.0.4 – Build 765w32/w64 – 
766x 

Release of RG for Rhapsody 8.0.4 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody and DOORS interface. 

Support of DOORS 9.5.1.2 
Gateway supports DOORS 9.5.1.2. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions. 

Rhapsody interface 

Add high level Requirements and Macro-Requirements 

Stereotype settings of Requirements and Macro-Requirements were inverted. This is now 

fixed. 
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RG 8.0.5 – Build 777w32/w64 – 
778x 

Release of RG for Rhapsody 8.0.5 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody and DOORS interface. 

General Improvements 

New Gateway Icon 

Starting from this version Gateway as a new application icon! 

 

You will find this icon in the Start menu group of Rhapsody Gateway. 

Support of DOORS 9.5.2 
Gateway supports DOORS 9.5.2. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions.  

Rhapsody Interface 

Add High Level Requirements 

Fixed inversion between Requirement and Macro-Requirement stereotype configuration. 

Other fixes related to UNICODE support and font size in Rhapsody requirement names. 
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RG 8.0.6 – Build 794w32/w64 – 
795x 

Release of RG for Rhapsody 8.0.6 (Windows & Linux). 

 

This maintenance release contains various fixes on the Rhapsody and DOORS interface. 

Global Improvements 

Guide Me 

The Gateway Welcome Page in Rhapsody now provides a link to a new Guide Me for the 

importation of DOORS requirements using the DOORS Wizard. 

 



RG 8.0.6 – Build 794w32/w64 – 795x 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

118 

 

Support of DOORS 9.5.2.1 
Gateway supports DOORS 9.5.2.1. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions.  

Rhapsody Interface 

Attribute Types Support in Add High Level Requirements 

Gateway is now properly synchronizing multi-valued attributes from high level 

requirements in Rhapsody Tags with strings and enumerated values. 

The corresponding Attribute types must be properly configured in the high level document 

types. Refer to the Rhapsody Coupling Notes and Customization Guide. 

Status Logging in Add High Level Requirements 

The Add high level requirements feature now comes with a new status dialog providing 

clearer details on operation performed, errors and warnings. 
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Rhapsody / DOORS Bidirectional Synchronization 

Status Logging for All Synchronization Operations 

Rhapsody and DOORS synchronization operations were improved to support a new status 

dialog providing clearer details on operations performed, errors and warnings at the end of 

synchronization process. 

 

In case of batch execution mode, the corresponding status is traced into the Gateway’s log 

file in text format. 

It is also possible to provide environment variable to save the trace in a XML file 

specified with the environment variable SYNC_LOG_XMLFILE. 

A backup can be created every times by specifying SYNC_LOG_XMLBACKUP=1. 
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RG 8.1 – Build 523w32/w64 – 
524x 

Release of RG for Rhapsody 8.1 (Windows & Linux). 

 

General Improvements 

Report Editor 

In Report Editor, it is now possible to create anchors. There anchors can be referenced by 

URLs defined in the same report model or by an external source. 

Instead of deleting all table when deleting a column title, only selected column is deleted. 

Find dialog 

Rhapsody Gateway  allows to use regular expression in Find dialog to search text. 

 

Report Generation 

A new report structure named Mark index entry is available to produce indexes in Word 

document. These index entries can then be collected by an index defined in template. 

On terminal elements, it is possible to set basic character styles like bold, italic, 

underline,… 

A separator string (comma, carriage return, space, …) can be defined on loops. 
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PDF Report Generation 

Tables are now correctly generated in PDF reports.  

PDF Generator works with Japanese and Chinese texts. 

It is now possible to modify output format. 

Options 

A new option Save absolute paths is available in Options dialog box to avoid saving 
absolute paths in .rqtf file. The goal is to prevent from modifications on the local copy of a  

Gateway project file that is under Configuration Management. 
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DOORS Interface 

Support of DOORS 9.6 

Gateway supports DOORS 9.6. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions. 

New DOORS Conversion Options Pop-up 

Most DOORS conversion options were moved to a new dialog accessible from clicking 

the browse button (…) in Value column when Options is selected in Variable column. 

 

Excluding Objects from Conversion Result 

It is now possible to exclude directly objects from the DOORS conversion result by 

specifying a condition on DOORS attribute value with the following syntax: 
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Rhapsody Interface 

Add High Level Requirements to Different Packages 

It is now possible to assign documents to different packages in the add high level 

requirements dialog. 

 

Use  and  buttons or drag’n drop to move documents from Documents list to 

Packages tree and vice versa.
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RG 8.1.1 – Build 533w32/w64 – 
534x 

Release of RG for Rhapsody 8.1.1 (Windows & Linux). 

 

This maintenance release contains various fixes. 

Code C, C++ and C# 
It is now possible to extract values from comment lines starting with particular keywords 

by specifying a regular expression in the attribute “type”. As a result, the comment regular 

expression behaves as a sub-regular expression and it is possible to extract multiple values 

more reliably. 

 

Code C AUTOSAR 
Added Code C AUTOSAR converter that supports particular AUTOSAR macro 

definitions in function signatures. 
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Rhapsody interface 
Now Gateway automatically adds Gateway project files as Rhapsody controlled files. 

 

This is only applicable to following project files that are located immediately under the 

Rhapsody <project>_rpy folder: 

 Project description (<project>.rqtf) 

 Project analysis (<project>.rqtfimage) 

 Project filters (<project>.filters) 

 Project marks (<project>.marks) 

 Project types (.types) 

 Automatic modification files (.xml) 

 Other files directly pointed by Gateway project documents 
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RG 8.1.2 – Build 353w32/w64 – 
354x 

Release of RG for Rhapsody 8.1.2 (Windows & Linux). 

 

This maintenance release contains various fixes and improvements. 

General Improvements 

Welcome Screen 

A welcome screen is available on Gateway startup providing basic actions like creating, 

opening a project and quicker access to resources (documentation, example …). Use menu 

View > Welcome Screen to show the welcome screen while a project is opened. 
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Rich texts 

When a rich text contains tables, these tables are now well displayed in rich edit widget 

even if it contains long texts. 

 

Types 

A checkbox is available in type editor for Attributes to type them as number. This allows 

numeric comparison instead of string comparison. 

Variable substitution is now possible in XML analysis tree. These variables are referenced 

using ‘$’ sign. Values are found in document among variable values defined on document. 

This function is used by ReqIF coupling to avoid multiple type definition. 

Snapshots 

To be more precise when creating snapshots, snapshots are now saved with the number of 

seconds in the file name. 

Project Editor 

When editing project, multiple covers can be created without clicking multiple times on 

Add cover button. 

It is now possible to assign a type of analysis to a folder. When a document is created in 
this folder, this type will be automatically applied. The goal is to save time during project 

creation. 
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Types Editor 

When pasting a type, if the type is already present in the current document type, a child is 

pasted instead of a copied type. This allows to add new parent to existing type. 

Report Editor 

Report elements dialog box can be displayed with all tree lists present at the same time. 

 

XML Analysis 

During XML analysis of types for multiple files, directory and file tags are available 

implicitely for XML capture allowing to realize multi-XML types for arbitrary files. 

Microsoft Word Viewer 
A new edit connector is available to use Word Viewer instead of Word. This connector is 

simplified regarding to Word connector as no API is available. When navigating, the 

Word document is opened without any selection. 
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Code C, C++ and C# 
It is now possible to extract values from comment lines starting with particular keywords 

by specifying a regular expression in the attribute “type”. As a result, the comment regular 
expression behaves as a sub-regular expression and it is possible to extract multiple values 

more reliably. 

 

DOORS Interface 

Support of DOORS 9.6.1 

Gateway supports DOORS 9.6.1. 

Gateway still complies with DOORS 7.1, DOORS 8.x, and previous DOORS 9.x 

versions. 

Rich text conversion and processing 

During conversion, object texts with images and OLE objects are saved in separate files to 

allow big DOORS modules analysis. 

Raw text processing is possible in addition to rich text extraction by specifying the 

following conditions on all <Text> tags: 

- plain="1" as plain text for conditions and regular expression processing, 

- show="1" as text to be shown that is likely to contain the plain text or the rich text. 
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Export to DOORS with Flat Mode 

Export to DOORS now provides an option to automatically filter out category elements of 

Rhapsody types during the export. 

Right-click the Types tree and activate Flat mode so the category types disappear. He 
option Keep children of filtered elements is automatically activated in order to export 

Rhapsody elements without their parent group. 
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